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装置使用の前に
以下のルールを守って下さい
• 研究室内は土足厳禁、飲食厳禁

• 装置の故障、不具合を見つけたらすぐに施設職員に連絡。緊
急連絡先は研究室入口ドアの横に記載してあります

• 装置を乱暴に扱わない
• 研究室の物品を勝手に持ち出さない

• 貴重品の管理は各自でする。休日や夜間利用の際、研究室の
施錠は各自で行う

• ステージの移動操作時、各装置のステージ位置稼働制限を守
る。動かし過ぎると試料が検出器などにぶつかり、故障します

• ソフトウェア、ハードウェア上のパラメータを変更した場合、装置
使用後に必ず設定を元に戻す

• 分析装置PCに直接自分のUSBなどの記録メディアを差し込まな
い。当研究室専用のUSBを利用し、解析用PCを経由してデータ
を取り出す

• 分析室内に導入するものは素手で触らない。備品を利用して汚
した場合は自分で洗浄する

• 使用者が予約を取って、予約時間通り使用する。変更の場合
は前日までにキャンセル。当日の予約キャンセルは無効です

• 装置利用中の故障トラブルは全て貴研究室の責任です。装置
利用について自分の指導教官に必ず知らせておくこと

• 初めて装置を使う際は事前に職員に連絡を取って講習を受け
る

• ガスが出やすい試料、大きすぎる試料、壊れやすい試料など、
分析室真空度を劣化させる試料は勝手に入れず、事前にス
タッフに相談する

• トランスファーベッセルを使用する場合、必ず施設職員に連絡
し許可を取る
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装置使用の前に

使用記録簿に名前や時間等を
記入。使用前の分析室真空度を
チェックして値を記入

使用後の分析室真空度のチェックと終了
時間の記入を忘れないで下さい。予約時間
とずれ込む場合は必ず先に予約を変更

Ar+イオンガンのイオン化室

真空度と分析室真空度をチェッ
クして下さい。通常は
✓ イオン化室 ~10−4𝑃𝑎
✓ 分析室 ~10−7𝑃𝑎

著しく真空度が劣化している
場合はスタッフに連絡

イオン化室

分析室

イオンガンユニットで
Channel/float voltageボタンを押し

て点灯させ、ディスプレイに表示さ
れた番号が「７」である事を確認

イオンガンの電流電圧条件が各Channelに
入力されており、Channel番号を呼び出す事

でイオンガンが各条件に設定されます。
Channel「7」はイオンガンが使えない設定に
なっています

イオンガンユニット
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試料の準備
装置の立ち上げ前に試料をホルダー
にセットします。ホルダー類は真空デシ
ケーターに保管されています。通常の
試料であればノーマルホルダーを利用

大型試料(100mmφ以下)専用ホルダーもあります。

ガスが出やすい試料や崩れやすい試料など不安な
試料はご相談下さい

留め金やカーボンテープなどを使い、
試料をホルダーに固定。試料が完全に
固定されているのを確認して下さい

• 粉末試料を扱う場合

カーボンテープを使用するか、金属薄
膜(Al、In、Siなど)に付着(圧着)させます。
ブロアーを30回以上は吹きかけて固定

出来ていない粉末を完全に飛ばして下
さい。またホルダーや固定した薄膜に振
動を与えて粉末をふるい落としてくださ
い。少しでも粉末が飛び散って装置に
残ると故障します。故障の原因になった
場合、修理代を請求します。ペレット加
工済みの粉末も割れるものはダメです

ノーマルホル
ダー(予備)

ノーマル
ホルダー

帯電試料用
ホルダー

帯電試料用
ホルダーの蓋

大型ホルダー

留め金&ネジ ホルダー固定台

少し高さがある試料
は底部を外して固定

留め金固定は必ず両脇に。固定後はホルダーを逆
さにしてみてしっかり固定しているか確認して下さい。
X線源と留め金&試料の位置関係に注意
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試料の準備(利用時)

・帯電試料用ホルダーについて

中和電子銃を使った帯電緩和を、試
料にバイアス電圧をかける事でより効
果的にします

試料下部に+100V印加し、GNDの蓋部と電位差を

つける事で中和電子を効率的に試料表面に当てる
事が出来ます。帯電緩和の他、Ar+イオンガンでの

エッチング時に、エッチングによる表面電位のズレ
を抑制する効果があります

写真のように試料を搭載し蓋をして
固定。試料の厚みは1.3mmが限度で

す。蓋部とホルダーの金属部が接着し
ないようにセットします。試料表面が蓋
部より出ないようにします

固定後にホルダーの蓋部と端子部の
間で導通が取れていない事を確認

導通があると蓋部に電圧をかけられないので効
果がありません

・試料の表面汚染について

空気中での表面汚染を出来るだけ防ぎたい場合、ドライプロセスで作成した試料については

作成後すぐにアルミホイルで包んだり、真空装置に保管して大気に晒さないで下さい。ウェットプ
ロセスで作成した試料についてはアセトン洗浄した後に超純水洗浄、すぐにエアーダスターなど
で十分ブローし、アルミホイルなどで包んでください

・試料のリファレンスピークについて

試料のチャージシフトの補正を行うのに、リファレンスとなるピークを試料に用意しておくと、解析
の際良いと思います(リファレンスとなるピークがないなら)。炭素を含む試料はコンタミ成分のC1s

ピークと試料由来の炭素のピークが重なってリファレンスに利用出来ない場合があるのでなおさら。
Au薄膜やAuメッシュを一緒に乗せて測定したり、試料にAuをコートしておいて一緒に測定するとか、
粉末体ならば他の化学状態が分かっている粉末を混ぜ込んだりして一緒に測定すると良いです
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試料準備室への導入
ホルダーを試料準備室に導入して真
空を引きます。準備室のロックを外し、
VENTボタンを押して準備室を大気に戻

します。マグネットリングを少し前にずら
して準備室内のレールを見やすい位置
に置きます。レールに水平にぴったりと
ホルダーを載せ、奥側にも接着

試料導入棒のマグネットリングを回し
て「OPEN」から「CLOSE」に変えます。リン

グを回すとレールの下のフックが上下動
します。下から覗き込んでホルダーの穴
にフックが入っているのを確認

ホルダーがセット出来たらマグネットリ
ングを後退させ、扉を閉めてロックをか
け、VENTボタンをもう一度押して真空に
引き直す

ここで失敗してると分析室に導入出来ません。必ず
ホルダーがちゃんとセット出来てるか確認して下さい

1

2

VENTボタン

どっち回しでも可

目視確認

準備室真空計

真空引きには小さな金
属板試料なら30分ほど、

カーボンテープで固定し
た粉末では2時間以上

かかります。真空を引く
間に装置の立ち上げを
行います

まだまだ引きます

スキマがない
か目視確認

マグネットリング

触らない

試料準備室

ホルダー裏
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装置の立ち上げ

始めに冷却器の電源を入れます。温度表
示を確認。次にSPECボタンとX-Rボタンを押し
て、点灯させます

冷却器の電源が必ず先です。消す時は必ず後です
X-Rボタンを押すともう一つの奥の冷却器が起動します

(音が聞こえます)。奥の冷却器が稼働してない場合、もう一
度X-Rを押し直して駆動音を確認して下さい

SPECボタン

X-Rボタン

ステージランプ、カメラ電源、カメラモニ
ター、測定用PC、PCモニターの電源を入
れます。PC立ち上げ後、デスクトップの
「SPECSURF Acquisition」をクリックしてXPS
ソフトウェアを立ち上げます

ステージランプ
カメラ電源

カメラモニター

カメラ本体は↑です
触れないで下さい

解析用ソフト

AcquireメニューからXPS
を選択して←のウィンドウ

が出れば問題ありません
(出なければ再起動)

冷却器
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装置の立ち上げ

X線の立ち上げを行います。始
めにX線源の種類を決めます
• Mg-Kα線
• Aｌ-Kα線
• モノクロX線(Al)

Mgの場合はAl/Mgボタンを点
灯、Al の場合は消灯させます。
モノクロX線の場合はAlを選び、
MONO/STDボタンを押して点灯さ
せます

線源選択後、FILAMENTの電源を
ON、ADJつまみをゆっくり回して
CURRENT表示で3.5Aまで電流を上
げます。上げてから5分待ちます

分析室真空度を確認して真空度が急激に劣
化しないように回して下さい。急ぐとガスが大
量に出て放電します

次にディスプレイの表示をX-RAY 
POWERに切り替え、X-RAY電源を
ONにします。3kV,5mAが印加され
ます。電圧つまみを3分毎に1kV上
げて10kVに、さらに3分後電流つま
みを5mA上げて10mAにします

モノクロX線の立ち上げの場合はX-RAYの
電源をON後に30分放置、その後12kV,25mA
まで３分ごと1刻みずつ上げていきます

最後にAnalyzerの電源をONにします
よく忘れるので注意

アナライザー電源

モノクロX線の場合

電圧 電流
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装置の立ち上げ
X線源の立ち上げ後、SPECSURFの

XPS AcquisitionからSourceタブを選
択。X線源の種類、電圧電流値を入
力後、Statusで「On」をクリック(「Off」
がついてたら先に「Off」をクリック)

Automatic Offにチェックをつけて設定すると
測定終了時にX線が自動でOffになります。測
定後しばらく放置する方は自動Off

StatusがUpdateに変わったら、X
線源ユニットのAUTO/MANUボタ
ンを押してAUTOに切り替える

以降、X線源の設定を変更したい場合は
AUTOからMANUに戻して下さい

測定範囲 角度絞り 視野絞り

3.0mmφ 36 36

1.0mmφ 24 12

0.7mmφ 12 10

0.2mmφ 12 8

0.03mmφ 4 1

測定範囲の設定は左画の2つ

の絞りで切り替えます。ロックネ
ジを緩めて、測定範囲を狭める
場合はCLOSE方向、広げる場合
はOPEN方向に絞りを回して左表
の数値に合わせます。36は
OPEN方向に一周分開いて0に合
わせます

回し過ぎに注意して下さい。間違った方
向に回さないで下さい

Depth profileなど、エッチング前後の様
子を見比べる場合は1㎜φまたは0.7㎜φ
に設定する

0.7㎜φを使用する時は3㎜&1㎜ modeを
選択してください。
ミクロ測定(0.2mm、0.03mm)を行う場合

はカメラの十字が正しい分析位置を指定
出来ているか検証出来るものを用意し、
検証した方がいいです

ロックネジ
CLOSE

OPEN
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分析室への導入

ステージの位置を試料交換位
置に移動させます。ステージコン
トローラーのP/Mボタンを押して
表示をMEMORYに切り替え、メ
モリーNo.をUP,DOWNボタンで操
作し、No.SEを呼び出します。
MOVEボタンを押すと表示された
位置にステージが移動します

基本すでに試料交換位置にいるので動
きませんが必ず確認して下さい

準備室の真空を十分に引いた状態
でV1ボタンを押してバルブ解放。導

入棒の黒いリングを手前に押して試
料を分析室に導入します。のぞき窓
からホルダーとステージを確認しな
がら入れて下さい。奥まで入れたらリ
ングを回して「OPEN」にし、黒いリン

グを後ろまで一番引き抜き、もう一度
V1を押してバルブを閉めます

少しでも違和感があったら無理に
入れず、スタッフを呼んで下さい

完全に0に
一致させる

1

2

3

ホルダーの溝にステージ
がはまります

一番奥で止まります リングを回してすっと
引き抜いて下さい

ステージコントローラー
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分析室への導入

V1バルブが閉まったら分析室真空度
を確認します。真空度が5.0 × 10−6Pa

より劣化してる場合、試料を直ちに試料
準備室に回収し、準備室で真空引きを
続けて下さい。再度導入し、 5.0 ×
10−6Paより良ければ、分析室で真空度
が落ち着くまでしばらく待ちます

10.0× 10−7Pa以下まで真空度を下げましょう

測定位置へステージレバーを使い、
ホルダーを移動させます。測定中心点
はカメラモニターに表示される十字で
す。試料が複数ある場合、位置をメモ
リーする機能を使うと連続測定が出来
て便利です。P/MボタンでMEMORYに
切り替え、UP,DOWNボタンでメモリー
したいNo.を呼び出し、ENTボタンを押
すと現在位置がメモリーされます

測定位置を合わせる時は必
ずZ軸も合わせてください。カメ

ラをズームさせて十字のセン
ターでカメラフォーカスが合う
ようなZ値を探します（モノクロ
X線ではやりません）

ずれてると分析位置が合いません。
強度も出ません。エッチングの位置も
ずれます

カメラズーム

カメラ本体に触れない

ステージレバー
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モノクロX線の設定(利用時)
モノクロX線を利用する場合、「装
置の立ち上げ」でモノクロX線を立

ち上げ終わった後、他に行う事が３
つあります
• 分光結晶の窓を開ける

本体中央にある左画の切替器で、
bakingからmonochromeを矢印に
合わせる

ロックネジを緩めてから回して下さい

• X線源の位置を引かせる

本体後ろにある左画のツマミを装
置正面から見て時計回りに回して、
X線源の位置を5mm後退させる

測定後、必ず元の位置に戻して下さい

• RatemeterでZ軸の調整
ステージTiltを-10°まで傾かせ、

目的試料を分析位置に移動。
Acquire→RatemeterでRatemeter
ウィンドウを立ち上げ、Centreに測

定元素のメインピーク値を入力し、
Start。ピークの強度がMaxになる
ステージZ軸の値を見つけ、その位
置で測定作業orステージのメモ
リーに記憶させる

RatemeterのPass、Dwell、Refresh timeなど
の値はZ移動によるピーク強度の増減が見や
すいよう適宜変更して下さい

XPS acquisitionウィンドウを閉じないと
Ratemeterウィンドウは出てきません
強度が取れない場合、Tiltを-20°まで傾け
ると取りやすいです。「Angle Resolved」の高
傾斜測定を参照してTilt制限を解除

ロックネジ

X線源位置
目盛り

後ろ側にある
ので誤って他の
パーツに触れな
いよう注意

切替器

Ratemeterウィンドウ
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Ar+エッチングの設定(利用時)

試料表面のコンタミネーションを削りたい場合、または深さ方向
のプロファイルを取る場合にAr+イオンガンの設定をします
モニターの十字を中心に3×3mmの範囲でエッチング出来ます

Ar+イオンガンエッチングは表面の化学状態に影響を与える場合があり、エッチングを行
いながら化学状態分析をする場合、エッチングによる影響について検証した方が良いです

試料導入後、分析室真空度が10.0×
10−7Pa以下になるまで待ちます

イオン化室の真空計でAVCボ
タンを押します。左画のArガス
バルブをゆっくり開きます。6時

を指すマーカーから反時計回
りにおよそ一回転させます。イ
オン化室ガス圧が上がります

奥のバルブ
を回す

Arガスバルブを微調整し、10.0×10-2Pa

で安定するようにします。少し置いて値が
上がるようなら締めて調整して下さい

 12.5 × 10−2Paを超えるとエラーになります。開け過ぎ
ないように
分析室の真空度も下がります。利用中、真空度は小

まめに確認して下さい。 エッチング中などに4.0 ×
10−5Paより劣化した場合はすぐにエッチングを中止して
オートバルブコントローラーを切り、Arガスバルブを時計
回りに回して閉めてください

オートバルブコントローラーの電源を
ONにします。バルブが締まり、イオン
化室真空計の値が一旦下がります

オートバルブコントローラー

Arガスバルブ

イオン化室真空計
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Ar+エッチングの設定(利用時)
Channelボタンを押してXつま

みを回し、エッチングの条件を
選びます。条件は下表の通り
です。

Etching rateはSiO2で測定したものです。
Ch5はモノクロX線測定の時にCh1と同じ
エリアでエッチング出来る仕様です

channel Ch1 Ch2 Ch3 Ch4 Ch5

Beam energy(eV) 3000 2000 1000 500 3000

Emis current(mA) 20 20 25 25 20

Gas Pressure(Pa/100) 9.5 9.5 7.0 6.5 9.5

Etching rate(nm/min) 6.0 4.0 1.5 0.3 5.5

Etching rate(nm/min) 6.0 5.0 2.0 0.5 6.0

XPS AcquisitionのExperimentタブから
Experimentを「Depth Profile」に切り替え
後、Profilingタブを選択します。Presetに
使用するchannel番号、Pressureに上記の
表の値を入力し、Setをクリック。次第にガ

スバルブが緩み、ガス圧が指定値付近で
落ち着けばAr+エッチングの準備は終了

(Depth profileの場合はここまでやる)

Irradiation ON/OFFボタンで

エッチングを開始出来ます。
Timer DisplayをONにするとエッ

チング経過時間がディスプレイ
に表示されます(Timer Resetを
押すと時間がリセットされます)

2023/7/28更新
最新のレート

以前のレート

9.0
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中和電子銃の設定(利用時)

導電性のない試料の場合、
光電子の放出によって試料表
面に不均一な帯電が発生して
しまう事があります。結果とし
てエネルギー値や半値幅に
影響を与えます

中和電子銃により、試料表
面に電子を供給する事で帯電
現象を緩和出来ます

中和銃未使用 中和銃使用

ガラスサンプル

・中和電子銃利用方法

1. 中和電子銃ユニットの電
源をON

2. SELボタンを押してADJUST
の項目をFIL.に切り替え、
ADJつまみを回し、適当な
電流値まで上げる

3. メニューのAcquireから
Ratemeterを起動させる

次ページに続きます

XPS Acquisition

を開いてる場合
は先に閉じる
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中和電子銃の設定(利用時)
4. Centreに強度の高いピーク

のエネルギー値を入力。
Pass、Dwell、Refresh timeは

ピーク形状が見やすくなる
ように適当な値に適宜変更

5. Startボタンを押し、各検出
器のCount数を確認

6. Acc.VをON。SELボタンで
ADJUSTをAcc.Vに変更後、
ADJつまみを回して電圧値

を変化させながら、
RatemeterでピークCount数

が一番大きくなる電圧値を
探す

7. 電圧値が見つかったらその
値で固定、Ratemeterを閉じ
て通常通りの測定を行う

ピークCount数だけでなく、ピーク位置、ピーク

半値幅も正常な値になるような電圧値を見つけ
る。試料ごとに適当な電圧値を見つける

・帯電試料用ホルダーを使っている場合

上記の電子銃設定を行う前に左図の
電源を起動させてホルダーに電圧を印
加させます
1. POWER ON
2. OUTPUT ON
3. CURRENTを微量流す
4. VOLTAGEを100.0Vに設定

直流電源装置



17

トランスファーベッセル(利用時)

トランスファーベッセルを使用する場
合は必ず職員に連絡すること
全ての作業を慎重に行うこと

トランスファーベッセルに衝撃を与え
ないこと

O-リングにゴミの付着などがないこと
を確認すること
ホルダーの導入に十分注意すること

グローブボックス内などでホルダー
に試料固定後、トランスファーベッセ
ルにホルダー封入。ホルダー設置の
方向に注意(左図参照)。しっかりと開
閉ノブを回して締めて下さい

試料準備室のロックを外してVENT後、
扉のブランクフランジを外す

試料ホルダー

トランスファーベッセル

ここから左部分は素
手で触らないこと！

この向きでホルダーを固定

ブランクフランジ

素手で真空部分を
触らないこと！

開閉ノブ



18

トランスファーベッセル(利用時)
ピンの位置を合わせてトランスファー
ベッセルを装着、固定リングを回して
扉に固定。扉のロックをかけてVENTボ
タンを押して真空引き

試料準備室の真空計で針が緑の範
囲に突入したら、ゆっくりと慎重に開
閉ノブを回してベッセルを開けて下さ
い。急に開けるとベッセル内の空気が
一気に試料準備室のターボポンプに
入り込みポンプが故障します。真空度
も確認しつつ慎重に開けて下さい

固定リング

真空引きの際、少しベッセ
ル本体を押し込んで下さい

開けるの中断じんわり開けましょう

ベッセル内も真空が引けたら開閉ノブを全
開にします。黒いリングを操作してホルダー
を受け取り、ベッセルを閉めます。試料準備
室の真空が十分に引けたらV1を開けて分析
室にホルダーを導入。V1を閉める。
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Wide scan

測定法は全部で6種類あります。どの
測定を行う場合でもまずはWide scan
で測定しておくと良いでしょう
ExperimentでWide scanを選択

現在のステージ位置で測定する場合は
MovementでNoneを選択、ステージコン

トローラーのメモリー機能を使う場合は
Memoryを選択

Lens Modeに設定した測定範囲を選択

Stageタブで連続測定するメモリー番号の
始めの番号(First)と終わりの番号(Last)を入
力(Memory選択時)

RegionsタブでWide scanの各条件を設定
Pass(eV)はエネルギー分解能と強度に関わります。値を

小さくすれば分解能が上がり、強度が下がります。大体
5eV程が限界です。Step(eV)間隔はPass(eV)の1/100程に
設定すると良いです。Scansは測定してみて調整します。
定性ならばバックグラウンドノイズの3倍、定量ならば10倍、
ピーク強度が取れるように設定します。Scan回数のルート
でバックグラウンドノイズは減少します(主にNarrow scan
時に設定)

Startボタンで測定開始しま
す。Checkボタンを押すと測定
予測時間が表示されます
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Markerの付け方

Wide scanを取ったらマーカーをつ

けてピークの同定をします。左画の
アイコンをクリック

スペクトル上にラインが現れます。ピー
クにドラッグして当てるとSuggested Peaks

に想定される元素一覧が表示されます。
Elementから元素を選択してAddを押すと

元素名がスタンプされます。元素によっ
てはChemical Shiftの一覧も載っており、
これもスタンプ出来ます。最後にOKをク
リックするとスタンプが残ります

Displayのチェックボックスで表示を各種変更出来ます

XPSハンドブックアイコンで標準試料のス
ペクトルを見る事が出来るので参考に

スペクトルには光電子ピークではないものが映り込みま
す。間違って同定してしまわないように気をつけて下さい。
サテライトピーク、オージェピーク、スピン軌道相互作用に
よる分裂など。他には、Mg-Kα使用時には、大きなピーク
の730eV高い位置にO-Kα由来、320eV高い位置にCu-Lα由
来、230eV低い位置にAl-Kα由来の小さなピークが見える
事があります(ゴーストピーク)が、偽物のピークなので無視

してください。また、近くに置いた別試料のピークが映る事
もあります
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Narrow scan
Wide scan後、定量や化学状態分析の

為、分解能の高いモードで各元素のメイ
ンピーク付近のスペクトルを取得します。
ExperimentでNarrow scanを選択します

Movement, Lens Modeは「Wide scan」を参照
Sourceタブは変更がなければそのままで

Stageタブでメモリー番号をセットします
(Memory使用時、「Wide scan」参照)。試

料によって測定内容が違う場合はここで
試料のグループ化を行えます。Groups
にグループ名を入力後Addをクリック。
First, Lastに1組の番号を入力し、Group
から名前を選択します

Comment欄に情報を入れとくと便利です。
左画はメモリーNo.1、2がCrグループ、No.3、4がPET
グループと登録されています。

RegionsタブでGroupを選択し
(Group登録時)、測定する元素を
Elementから選択します

Wide scanスペクトルを開き、

左画のアイコンをクリックすると、
スペクトル上にStartライン(緑)と
Finishライン(赤)が表示されます。

ピークに合わせてライン位置を
調整すると、測定範囲の条件に
反映されます

全てのWide scanで確認しましょう

残りの項目も適当に設定
します(特にScan回数、
「Wide scan参照」)
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Narrow scan

測定中、経過をAcquisition Statusで
確認出来ます。Pauseを押すとscan1巡

後に測定が中断され、左画のように
Scans回数だけ変更出来るようになりま
す。変更後Continueをクリックすると測
定が再開されます

Stopを押すとscan1巡後で測定終了になります
Abortは強制終了

・スペクトルウィンドウについて
カーソルをスペクトル上にやるとウィンドウ右下にエネル
ギー位置と強度が表示されます。左上には表示スケールの調
整ボタンがあります。一度の測定で得たスペクトルは一つの
ウィンドウに格納されています。各sample、各Region、各Level
はウィンドウ右上のメニューから表示を変更出来ます
データのSave, Openなどもウィンドウ単位。Memory番号、出
力したデータの表記番号が1番からに対し、表示上のsample
番号は0番から付けられます。間違わないで

・Narrow scanでピークが小さすぎて取れ
なかった場合
元々微小量の元素のピークだとたくさんスキャンしてもピー
クがまともに取れない事があります。その場合はPass、Dwell、
Stepをそれぞれ2～3倍に変えて測定を実施してみて下さい。
ピークは20～30％ほどブロード化しますが感度は2，3倍近く
上がり、ピークがしっかり見える場合があります。
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Depth Profile
Depth ProfileではAr+エッチングと

測定を交互に繰り返す事によって、
試料の深さ方向のプロファイルを取
得出来ます

ExperimentでDepth Profileを選択

し、イオンガンのガス圧調整を行う
(「Ar+エッチングの調整」を参照)

Acquisition ModeでFullを選択
Separate(PB別法)とSimultaneous(PB同時法)
を選択するとPeakとBackgroundのエネルギー

位置を指定してその差分強度だけを取得しま
す。スペクトルを取得しない分高速で測定が出
来ます。元素のピーク強度プロファイルだけ取
れればいい場合に使えます(「Image & 
Linescan」参照)

Profilingタブでエッチング時間の
設定を行います

左画では1回目(levelという単位)の測定前に0
秒、2回目~4回目の測定前に各15秒、5回目
~10回目の測定前に各60秒ずつエッチングを
行うようになっています

あとの設定は「Narrow scan」と同
様です。補足として、

・ガス圧の設定を行ってからガス圧が上がるの
を待って測定を始める
・SourceタブではStatusでAutomatic OFFを推奨

・アトミックミキシング、選択スパッタリング等を
考慮した解析が必要な場合があります
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Angle Resolved

Angle ResolvedではステージのTilt

をアナライザー軸に対して徐々に傾
けながらスペクトルを取得して、非破
壊で試料の深さ方向のプロファイル
を取得出来ます

高傾度測定をしたい場合の以下の
設定をします

最大80°まで傾けられるので平均分析深さ
6nmから1nmぐらいまでのプロファイルを取得出
来ます
高傾度にする事で測定する表面の領域がY方

向に伸び、信号量を増やす事も出来ます。微小
量分析に向いてます

ステージを大きく動かす分析なので十分に気
を付けて下さい。事前にスタッフにご相談下さい

分析後は必ずハード・ソフト共に設定を元に戻
して下さい

このモードで測定する際はステージのメモリー
に位置を登録を最後に消去して下さい

・XPS本体での設定

試料を分析室に導入。傾ける
ので必ずホルダーに試料をしっ
かり固定する。ロックネジを外し、

磁場レンズステージのマイクロ
メーターを回し、Z=17.95から
Z=8.5付近まで下げる。下部に

あるスイッチが押されるのを確
認する(小さくカチッと音がしま
す。回し過ぎると壊れます)。外
したロックネジを再び締める

磁場レンズステージ

磁場レンズ

スイッチ

マイクロメーター

ロックネジ
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Angle Resolved

・Spec Surfでの設定
View→ConfigurationからSystem 

Configurationダイアログを立ち上げ
て、Sample HolderでHigh Angleを選
択します。Tilt制限が解除され、-
30°から80°まで動かせるようにな

ります。以降、十分に注意してス
テージ操作して下さい

高傾度測定の場合は後はWide&Narrowの分
析をするだけ

ExperimentタブでAngle Resolvedを
選択し、Profilingタブでステージの傾

ける角度の設定を行います。左画の
設定だと0°から80°まで5°ずつ

傾けながら各レベルのスペクトルを
取得します。X線源の位置を下げな

い状態ではマイナス側へは１０°以
上傾けるのは禁止
残りの設定は「Wide Scan」、
「Narrow Scan」を参照
ホルダーがX線源にぶつかりそうな
場合はX線源の位置を必ず下げる
(「モノクロX線の設定」参照)

←マイナス方向に傾け
るとX線源にぶつかる恐

れがあるので、基本禁止
です。スタッフにご相談
下さい

Configuration
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Total Reflection
Total ReflectionではモノクロX線を使
用し、X線の全反射が起こるようス

テージの位置関係を調整する事で通
常の測定深さから約2/3浅く、またS/N

比良くスペクトルを取得出来ます。主
に試料表面の汚染物質の評価に利
用出来ます

平滑な表面を持つ試料(Siウェハーなど)でなけ
れば測定出来ません

・Total Reflection測定方法

1. 試料表面がステージと平行になる
ようホルダーに設置、試料導入

2. モノクロX線を立ち上げ、Ratemeter

で試料の光電子スペクトルを確認
しながらZ位置を調整します(「モノク
ロX線の設定」参照)

3. EｘperimentでTotal Reflectionを選
び、Tiltを-10°から-5°まで0.2°

ずつ傾けて適当にスペクトルを取
得、S/N比の傾向を確認

4. -4°から‐1°まで1°ずつ
Ratemeterでスペクトルを確認しな
がら、強度が出るよう再度Zの調整
(追い込み)をします

5. Zの調整が終われば-1°でスペクト
ル測定を行います
試料やホルダーが少し傾いていると-1°で測定
出来ません。S/N比が良い適当な傾きをRatemeter
で見つけて測定を行って下さい

Wide   BE (eV)
1000 800 600 400 200 0

ar
bi

tr
ar

y 
un
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s

20140328_133719_Wide_
20140328_132916_Wide_

青：通常測定 赤：全反射X線測定
BackgroundでGainを合わせると、コン
タミネーションのCのピーク強度が2倍
ほど大きくなっているのが分かる

C1s

O1s

Si2p

O 1s  BE (eV)
540 536 532 528 524

0
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1500

2000

工程3を飛ばしてもそんなに問題あ
りません
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Image & Linescan
Imageでは最大5.0×1.8cmの元

素マッピング像を取得出来ます。
ケミカルシフトを利用して化学状態
の違う元素のマッピングも可能

まず事前に取りたい元素の
Narrow scanを取得しておきます

ExperimentでImageを選択し、
Acquisition ModeでSeparate(PB別
法、設定が楽)かSimultaneous(PB
同時法、測定が速い)を選択します

・Separate(PB別法)
Regionsタブで取得したNarrow 

scanのスペクトルを元に、Peak、
Bk1、Bk2の値を設定します

Bk1は低エネルギー側バックグラウンド、
Bk2は高エネルギー側バックグラウンドに合
わせます。ここではSiO2由来のSiピークと
metal-Si由来のSiピークに対してPeak,Bk1,Bk2
を設定しています

・Simultaneous(PB同時法)
Channels欄をクリックし、各

Channel(検出器)で取得する強度を
BackgroundにするかPeakにするか
選択します。Range値(全検出器で
測定出来るエネルギー幅)が測定

したい元素の高エネルギー側
Background,Peak,低エネルギー側
Backgroundを抑え込めるように
Pass値を適当に変更します

PB別法

PB同時法
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ステージコントローラーでimage像

を取得したい試料の範囲の、左上
のステージ位置をmemoryNo.1に、

右下のステージ位置を
memoryNo.2に記録させます

No.1

No.2

マッピング
領域

ImageタブでReadボタ

ンをクリックし、メモリー
位置を読み込みます。
Scan ではSizeかStepか

選択し、像の解像度を
決定します。Modeでは
Imageを選択します←マッピング結果の各

元素の画像を色分けし
て重ねる事も出来ます

左図は赤:Si 青:Auの広域
マッピング結果です

Image & Linescan

ModeでLinescanを
選ぶとNo.1から
No.2の位置までの
線分析を行います

Siピーク
(SiO2)

Siピーク
(metal-Si)

←Simultaneous(PB同時
法)でのLinescan結果

これはSiウェハーの真ん中
をAr+エッチングしたもの

Si(SiO2)

Si(metal-Si)
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データの基本的な処理
測定したスペクトルデータは全
て自動で日付・測定法・線源で名
前が記されてAuto Storageフォル
ダに保存されます

File→OpenからAuto Storageフォルダを選

択し、データを選択するとウィンドウ下部に
データの詳細が表示されます

スペクトルを別の形式で保存す
る場合はFile→Save asでファイル
の種類を選択して下さい

SpecSurfデータの他、テキスト形式と
VAMAS形式が出力出来ます

File→Reportでスペクトルをレ

ポート形式で画像として出力出来
ます。スペクトルウィンドウ上でコ
ピーをクリックして画像として貼り
付ける事も出来ます
データをXPS-PC上で個別に管理

しておきたい場合はデスクトップ
にある「data」フォルダ下に研究室

単位でまとめて保存するようにし
て下さい

基本的にデータの管理は各自で行って下
さい。データ保存については保障しません
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終了の手続き
・帯電試料用ホルダーを使用した場合

電圧・電流値を0にする
OUTPUT OFF
POWER OFF

・中和電子銃を使用した場合
電圧・電流値を0にする
Acc.V OFF
電源 OFF

・Ar+イオンガンを使用した場合
オートバルブコントローラー OFF
Arガスバルブを時計回りに9時方向(1/4回転)ぐらいまで閉める
3分待つ
Arガスバルブを時計回りに6時方向(3/4回転)まで閉める
イオン化室真空計のAVC OFF
イオンガンユニットのChannel番号をXつまみを回して「7」に戻す

・Angle Resolved測定を行った場合
ステージを試料交換位置に移動
X線源の位置を元に戻す(ずらした場合)
磁場レンズのZ軸をZ=17.95に戻し、ロックネジを締め直す。
Configurationダイアログのholder設定をStandardに戻す
ステージメモリーに登録した位置情報を全部消去

・モノクロX線を使用した(Total Reflection測定を行った)場合
ステージを試料交換位置に移動
X線源の位置を元に戻す
分光結晶の窓を閉め(Bakingに合わせる)、ロックネジを締める
次ページの「X線源を落とす」作業後、15分経過したらMONO/STDボタンを
押してSTDに戻す
Tiltを-10度より上に傾けている場合、
「Angle Resolved測定を行った場合」の手順を実行する

・トランスファーベッセルを使用した場合
ホルダーを試料準備室に回収後、ベッセルにホルダーを再封入
扉ロックを外してVENT。VENT後、ベッセルを外してブランクフランジをつける
扉をロックし、試料準備室の真空引きを行う。
問題なく真空が引けているか確認する

まず初めに、下記ケースに応じて終了手順を
進めて下さい。順番を必ず守って下さい
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終了の手続き

・X線を落とす
Auto/ManuボタンでManualに変更
X-RAYの電流を最小値に、電圧を最小値にする
X-RAY電源をOFF
Displayの表示をFILAMENT POWERに変更
FILAMENTのADJつまみを回して電流を0にする
FILAMENT電源をOFF
SpecSurfのXPS acquisitionのSourceタブでOffをクリック

・試料の取り出し
ステージコントローラーのP/MボタンでMEMORY表示に変更
UP,DOWNボタンでNo.SEを表示させる
MOVEボタンを押し、試料交換位置へ移動
V1ボタンを押してV1バルブを開ける
試料交換棒の黒いリングをOPENの状態にして前方に押し出す
黒いリングを回してCLOSEにする
黒いリングを一番後方まで引き、試料を試料交換室に回収
V1ボタンを再度押してV1バルブを閉める
試料交換室のロックを開ける
VENTボタンを押して交換室を大気に開放
黒いリングを回してOPENにする、ホルダーを回収
試料交換室のロックして、VENTボタンを押し、真空に引く

・XPS装置本体の終了＆その他の作業
ホルダーから試料を回収、ホルダーは洗浄後、真空デシケーターに入れ
て真空を引く。作業台を片付ける
アナライザー電源 HTをOFF
カメラ、カメラモニタ、ステージランプをOFF
研究室USBメモリで測定データを解析用PCに移動
Spec Surfを終了後、PCシャットダウン、ディスプレイOFF
X線源を落としてから15分経過後、(モノクロX線利用時、MONO/STDをSTD
に切り替えてから)X-R、SPECボタンをOFF
冷却器の電源をOFF
分析室真空度をチェック、終了時間と共に使用記録簿に記入
他の装置使用者などがいない場合は研究室の照明を落とし、施錠を行う

全ての測定で共通の手続きです。順番を必ず守って下さい
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